
 

Digital Content Store: Accessibility opportunities 

The accessibility potential of digital content 
Accessible digital content makes users more independent and productive. The range of 

advantages will depend on different factors but, where digital content has been created using 

standard good practices, users should be able to personalise their experience by 

• changing the background colour, 

• magnifying the content up to 400%, 

• enjoy reading magnified content without having to scroll left or right, 

• see an outline of a document’s content by viewing all the headings and subheadings and 

the way they nest together, 

• instantly navigate to any heading or subheading, 

• listen to text content as an alternative to reading it visually, 

• read alternative text descriptions for graphics and images, 

• change line spacing, letter spacing or word spacing to make reading more comfortable. 

In addition to all these advantages, the digital nature of electronic resources means a user can 

have a library of books, articles and journal extracts on a phone, tablet or laptop without having 

to carry around bulky physical copies. People who struggle to manipulate a traditional book can 

interact independently with digital versions. People with literacy difficulties (for example 

working in a second language) can instantly get dictionary definitions. Blind users can read 

independently via audio (a screenreader) or tactile reading (refreshable Braille displays). 

The Digital Content Store has - by its nature – content from many sources. This means the 

accessibility of the content varies. This guidance explores: 

• factors influencing the accessibility of DCS content, 

• accessibility advice for academics and librarians using the content, 

• accessibility tips for end users - identifying the best reading tool for different user needs. 

Understanding the accessibility jungle 
Despite the accessibility potential of digital content, resources in the Digital Content Store (DCS) 

come from a variety of sources, created in different ways by people with different skill levels 

using different tools. Figure 1 illustrates some of the variability which makes it difficult to 

guarantee any specific level of accessibility with DCS content.  



 

 

Figure 1 – Reasons for accessibility variations in DCS content. 

Exploring the variables 

• Source - whether a document is scanned from hardcopy or “born digital”- will influence 

its accessibility. 

o Scanned documents may have more less accessibility depending on whether 

▪ it’s simply an image from a flatbed scanner/document camera or whether the 

image has been run through Optical Character Recognition (OCR) software to 

turn it into selectable text.  

▪ the person doing the scanning has the skill to create an OCR version and then 

tag it appropriately with headings, subheadings, reading order, image 

descriptions et cetera. 

▪ the scanning has been done for a specific user need - for example a 

magnification user has different requirements from a screenreader user. 

▪ the subject matter poses specific accessibility issues, for example 

mathematical symbols, formulae or music notation. 

o Born digital documents have different issues. This includes: 



 
▪ the tool used to create them. Adobe In Design, Quark Xpress, Adobe Acrobat, 

Articulate, Microsoft Publisher etc can all produce PDFs, but the accessibility 

features can significantly vary. 

▪ the accessibility awareness of the production team and their accessibility 

training.  

▪ any technical protection measures employed - for example if the content can 

only open in a specific reading tool, the user is constrained by the features 

available in that tool. 

▪ The nature of the subject matter (as mentioned above – equations etc). 

• Reading tool chosen - different reading tools have different accessibility strengths and 

weaknesses. For example, although you can magnify a PDF in browser, you cannot get 

the text to reflow. Nor can you change the background colour, yet the browser may give 

the best experience for text-to-speech. 

• User awareness - even when a PDF has been produced to the highest accessibility 

standards and is viewed through the optimum reading tool, a reader may simply not 

realise the options available to them. Most of us are self-taught on the technologies we 

use daily. 

  



 

Accessibility advice for HE contributors 
All the variables listed above are relevant when individual institutions upload content into the 

Digital Content Store. From an accessibility perspective, the following are key considerations: 

Born digital content 

Where content used in teaching is created in-house and loaded onto the Digital Content Store, 

the following should be checked before uploading the content. 

This is good practice This is why 

Create headings and subheadings 
using appropriate heading styles/tags. 

Reading tools and assistive technologies allow users 
to see a nested overview of all headings and navigate 
instantly through the document. 

Hyperlinks should be unique, 
informative and plain English. Avoid 
“click here” or raw URLs. 

Assistive technology users can rapidly navigate a 
page by generating a list of the hyperlinks, but this 
only helps if hyperlinks are unique and meaningful. 

Use built in list tools for bulleted lists – 
don’t make “look alike lists”.  

Assistive technologies can instantly identify a 
properly formed list and provide a spoken navigation 
between lists and within lists. 

Where images have a teaching 
purpose, describe the relevant parts of 
the image in the image Alt text field. If 
the images decorative, mark it as such. 

People who cannot see the image must not be 
disadvantaged by having no access to any unique 
information it portrays. 

Use tables only for organising data and 
information, not for page formatting. 
Mark the header row. Avoid split or 
merge cells. 

Simple table layouts have reduced cognitive load for 
neuro diverse reader and are significantly easier for 
blind readers to navigate with screenreader tools. 

Where documents have a complex 
structure with multiple columns, 
callouts and text boxes, ensure they 
are tagged appropriately so the 
reading order makes sense. 

Readers relying on text-to-speech or screen readers 
can have very poor and confusing experiences of 
your document if the reading order has not been 
manually checked. 

Scanned content 

Where a journal article or extract from a book is being digitised, there are three stages where  

accessibility can be optimised: 

Preparation and imaging: 

• Ensure the article has been cleared of pencil marks, underlining or other artefacts. 

• Ensure the scan quality is as good as possible either by adjusting settings (flatbed 

scanner) or optimising lighting (if photographing articles). 



 
Care taken at the scanning stage will result in more accuracy at the Optical Character 

Recognition (OCR) stage.  

Value: Content uploaded at this stage will have poor accessibility for disabled users. 

Postprocessing 1: optical character recognition 

An image of text has virtually no accessibility value other than being easier to carry around than 

a set of printouts. The vital first stage in making scans more accessible is to turn the image into 

selectable text that can be magnified, reflowed, and read out loud by assistive technologies. Use 

OCR software to achieve this. Always check the OCR output. Errors in text recognition can 

completely alter the sense of statements, resulting in misunderstanding. 

Value: Content uploaded at this stage will have value for users who need to change 

magnification or background colours as well as sighted users wanting to listen to content. 

Postprocessing 2: tagging for accessibility 

The optical character recognition stage will reproduce the visual appearance of the text, 

including headings and subheadings. But these will not work as semantic headings that assistive 

technology users navigate the page.  Therefore, the final stage of processing is to apply the 

checklist under the Born digital content section above.  

Value: Content uploaded at this stage will have value for all users. 

Checking DCS content for a disabled user 

When sourcing digital content from DCS it can be useful to know whether it might create any 

barriers for disabled users. The quick checks below enable you to identify some of the common 

barriers that can occur with PDFs. 

Quick check 1 – Copy/pasting 

Try to from copy and paste some text from the PDF to another 

application, for example, Microsoft Word or Notepad. 

Success? If this works, the PDF has had Optical Character 

Recognition applied. It should work with text-to-speech and – 

potentially - with screenreader tools. 

Quick check 2 – OCR and reading order  

Open the PDF in Adobe Reader and save it as text (File, Save as 

Text). Open the text file in Notepad then copy and paste it into 

Microsoft Word. Use Word’s Editor feature (under the Review tab) 

to check for  

• spelling errors (possible OCR misinterpretations) and 



 
• grammar errors (possible reading order issues). 

If the original document contains complex layout, identify some key words (for example, in a 

callout box in the original) and search for it in the Word version to check the content appears in 

the right context. 

Success?  If this works, the document has been OCR’d effectively and likely has a good reading 

order for text-to-speech and screen reader users.  

Quick check 3 – Navigation 

A navigable heading/subheading structure is essential for 

accessibility. Open the PDF in Adobe Reader then look for the 

bookmarks symbol in the side panel (arrowed in screenshot). If 

there is no bookmarks symbol, users can’t navigate rapidly 

through the document, however, navigational headings may still 

be available to screenreader users. This can be quickly checked by 

loading the PDF in Microsoft Edge then loading Windows Narrator and pressing CapsLock+F6 to 

bring up a list of all the headings in the document. Make sure the headings revealed to the 

screenreader match the visual headings on the page. 

Success? If you can navigate via the bookmarks pane, the document is accessible to all users 

who want to navigate more effectively. If there are no bookmarks, but Windows Narrator 

reveals headings, the document navigation will be accessible for screenreader users only. 

Quick check 4 – Magnification with reflow 

PDFs are generally very good at magnification, but 

magnification alone does not create an accessible 

document. In order to meet accessibility standards, 

it should be possible to magnify a document so the 

text reflows to fit the screen, irrespective of the 

magnification level. This can be tested quickly in 

Adobe Reader. 

First, select View, Zoom, Reflow. Then increase the 

magnification level to 400%. Look out for the following common issues. Sometimes pages simply 

will not magnify in the reflow mode. Sometimes one page will but another won’t. Sometimes the 

spaces between the words disappear. Sometimes reflow appears to have worked but when you 

check between page breaks you find whole paragraphs of text have disappeared, reflowing 

“under” the next page. 

Success? If you can successfully reflow and zoom to 400% without text at the page ends 

disappearing, the document will be usable by a wide range of readers with vision impairment, as 

well as those working on different sized screens. 



 
 

Quick check 5 – Colour change 

Open the PDF in Adobe Reader. Click on Edit, 

Preferences, Accessibility. In the Document 

Colours Options panel, click on the checkbox 

Replace Document Colours. Then click in the 

Custom Color checkbox.  

Try changing the page background to a different colour. Skim through the document to see if all 

pages have changed to the new background colour. 

Success?  If this works, the document will be suitable for readers requiring different colour 

backgrounds as a result of their neuro diversity or their vision needs. 

  



 

Accessibility advice for readers – tools and approaches 

The art of the possible 

The best reading experience depends not only on having PDFs that have been created to 

accessibility standards. It also depends on your choice of reading tool. Different reading tools 

support different accessibility features 

If you have the right combination of an accessible PDF and the optimum choice of reading tool 

for your particular need, you will be able to do any of the following: 

• change background / foreground colours,  

• magnify text (up to 400%) and have it reflow to fit the screen width, 

• change line spacing and letter spacing, 

• navigate instantly to any part of the document using headings and subheadings, 

• visually select content and listen to it being read out using text-to-speech tools, 

• navigate effectively and listen to all content using screenreader tools. 

Comparing PDF readers for personalisation options (best to worst) 

Reading tool Accessibility strengths Accessibility weaknesses 

 

  
Adobe Acrobat 

app for 
Android / iOS 

Best option for phone or tablets. Liquid 
mode attempts to identify headings even 
when the document is untagged. Good 
magnification with reflow and adaptable line 
spacing and letter spacing. Text to speech 
not available in liquid mode but works well 
in normal mode. 

Only alternate colour option 
is Dark Mode. 

 
Adobe Acrobat 

Good for changing background colours. If 
the document has been created accessibly, 
the bookmarks panel allows easy navigation 
and magnification with reflow is likely to 
work. 

Text-to-speech options are 
clunky. It is not possible to 
change the font type, letter 
spacing or line spacing. 
Unless tagged, reading order 
can be difficult to follow. 

 
Edge browser 

Built in browser Text-to-speech works well. 
If the document has been tagged with 
headings, these will show in the document 
outline section of the PDF viewer. Chrome 
can achieve the same benefits with the 
Selection Reader plugin. 

It is not possible to change 
background colours, line or 
word spacing. The document 
can be magnified, but text 
cannot reflow so will spill 
outside the viewing window.  

 
Adobe Digital 

Editions 

Minimal. The Android and iOS editions score 
between 1 and 2 stars on reviews. The 
Windows edition is no better. Not 
recommended for reading PDFs. 

No colour options, reflow or 
text to speech. No line or 
word spacing options. 

https://chrome.google.com/webstore/detail/selection-reader-text-to/fdffijlhedcdiblbingmagmdnokokgbi


 
Alternative approaches. 

Image of text 

Where the PDF is only a scanned image of text, Google Drive can perform optical character 

recognition (OCR). Load the document into Google Drive then choose to open it as Google Doc. 

From there, you can save it as a Word document and enjoy the accessibility features of Word’s 

Immersive Reader. 

Actual text 

If you have a PDF that has already been turned into text, try opening it directly in Microsoft 

Word. Browse to the PDF, open it and when prompted and click Okay to the file being converted 

to Microsoft Word. This can take a little time with a big document. Results are usually good 

unless a document is complicated in its formatting or contains a lot of maths or science symbols. 

Once in Word, use the features of Immersive Reader 

Finally, be prepared to be experimental. There are a huge number of reading apps on the 

market, both free and commercial. Some, such as @Voice reader for Android or Calibre for 

Windows, offer a wide range of personalisation options. But there may be trade offs between 

personalisation, complexity and all-round performance. Fully featured readers like Calibre take 

longer to configure but can be excellent for specific requirements (like line spacing) but may be 

awful in other ways (like handling multicolumn PDFs). 

Your needs are specific to you. Finding a tool that enhances your reading may mean trying a few 

options first. The next section gives you a short cut to finding the best approach for your specific 

wants or needs. 

  

https://calibre-ebook.com/download_portable
https://calibre-ebook.com/download_portable


 

Accessibility advice for readers – needs and preferences 
In the section on Tools and approaches we identified that the right combination of an accessible 

PDF with an appropriate reading tool would give you an optimum reading experience.  

Unfortunately, given the range of ways PDFs are produced, and the range of accessibility skills 

possessed by the authors, there is no guarantee that any specific PDF on the Digital Content 

Store will have a high level of accessibility. However, you can significantly improve your 

experience of any PDF if you know the best tool to use to get the results you want. This section 

is about helping you to get the best reading experience by making savvy choices.  

Please note, all the techniques below work only on a PDF containing actual, selectable text. 

None of these will work on a PDF that is simply an image of text. 

Change background / foreground colours  

Changing the background and foreground colours can  

• reduce eye strain, especially in very high or low light levels. 

• prolong battery life on mobile devices, 

• improve reading comfort for neurodiverse readers, 

Recommended approach 

For most users the simplest approach is to use the free Adobe Reader for Windows and Mac. 

• open the PDF in Adobe Reader, 

• choose Edit, Preferences, Accessibility, Replace Document Colours, Custom Colors. 

• Select the Page Background and Document Text colours you desire. 

Alternative options 

• Open Microsoft Word. Open the PDF in Word. Change the background colour either by 

o clicking Design tab then Page Color or  

o clicking the View tab and choosing Immersive Reader, Page Color. 

• In the Adobe Acrobat App for Android or iOS, load the PDF then 

o Switch off Liquid Mode (Blue coloured teardrop icon = “on”, grey = “off”), 

o Click on View settings, 

o Choose Dark mode. 

 

 



 
Magnify text (up to 400%) and have it reflow to fit the screen width 

Once the PDF has been processed and has selectable text, it should be possible to magnify it in a 

way that forces lines of text to reflow, so you do not need to scroll left or right to get to the 

beginning or end of a line. This benefits people with visual difficulties and can also give the text 

more space to “breathe”, thus supporting word recognition. 

Recommended approach 

The most reliable approach for magnification and 

reflow is to use the Adobe Acrobat App for Android or 

Apple devices. The Liquid Mode provides text options 

that include magnification to over 400%. As a result of 

the small screen size of mobile devices, the best 

experience comes from using the device in landscape 

mode. This is shown in the phone screenshot (right). 

Where documents use tables for layout (generally a bad 

practice anyway!) the text will still reflow, but the table 

cells give less room for expansion. This may result in 

words spilling across several lines. In the accompanying 

screenshot, a quote (“We’ve got your back”) has 

become a vertical stack of letters due to the small size 

of the table cell. The larger cell with the “Work where 

you want” quote is still comprehensible.  

The accessibility choices of the document creator can potentially undermine the final user 

experience, but the Adobe Acrobat app for Android or iOS currently gives the most reliable and 

robust reflow when magnified. 

Alternative approaches. 

• The Adobe Acrobat Reader for Windows and Macs can give good magnification and 

reflow provided the documents are either simple in format or created accessibly. 

o open Acrobat Reader and load the file, 

o click View, Zoom, Reflow then increase the magnification using the + / - buttons 

on the toolbar.  

• Alternatively, load the document into Microsoft Word and either 

o click View, Web Layout, then magnify using the slider on the bottom right of the 

Word window or 

o click View, Immersive Reader then use the magnification slider.  



 
Change line spacing and letter spacing 

People working in a second language and people with neuro-diversities such as dyslexia can find 

text easier to read when line spacing and letter spacing are increased.  

Recommended approach 

The Adobe Acrobat App for Android or Apple devices has a 

“Liquid mode”. In addition to the magnification options 

mentioned above, this mode gives a range of options for line 

spacing and word spacing. By clicking on the Reading Settings 

icon (Aa) you open a panel at the bottom of the screen with  

• 4 options for line spacing and  

• letter spacing options ranging from 75% to 125% of the 

default spacing. 

Once you’ve chosen the letter and line spacing to suit your 

needs, click away from the Reading Settings panel and continue 

reading. One of the best things about the app is that it retains the settings so the next time you 

load a PDF and enter Liquid Mode, your preferred line spacing, letter spacing and magnification 

will be remembered. 

Alternative approaches. 

• Open the PDF document in Microsoft Word, 

o for quick, easy but limited options, click View, Immersive Reader, 

o then click on the Text Spacing option. This will make both line spacing and letter 

spacing larger, but you have no options other than on/off. 

o For more options, you can select all the text and, from the Home tab, choose 

Paragraph, Line and Paragraph Spacing. This gives no control over letter spacing 

but gives fine control over line spacing. 

Navigate instantly to any part of the document using headings and subheadings 

If a PDF document has been created using heading styles 

or appropriate bookmarks, any PDF reader will be able to 

navigate it, even the otherwise weak Adobe Digital 

Editions tool. However, it is often the case that the 

headings and subheadings in a document have been 

created using formatting rather than style tags. These 

won’t show up in the document outline view in browsers 

or the Bookmarks pane in Adobe Reader.  



 
Recommended approach. 

The Adobe Acrobat App for Android or Apple devices has the twin benefit of  

• identifying and revealing any heading structure that has been added at authoring stage, 

• interpreting a heading structure from the typography where any structural tagging is 

absent.  

These twin benefits make this a sensible “first option” to try. However, if your normal workflow 

is to use either a browser or Adobe Acrobat Reader (Windows or Mac) it is quick enough to 

identify whether headings are present – and if not, to load use the phone/tablet app as a fall 

back. 

Alternative approaches. 

• Opening the PDF in a browser: 

o Edge - on the top left of window look for the Contents button. When it opens the 

contents pane, click on the List view. If there is no List view available, it means 

there are no headings in the document. Use the Adobe Acrobat app for Android 

or iOS instead. 

o Google Chrome - on the top left of the window look for the Menu button. When 

it opens the menu pain, look for the Document outline button. If there is none 

available, then there are no headings in the document. Use the Adobe Acrobat 

app for Android or iOS instead. 

o Firefox - on the top left of the window, look for the Toggle sidebar button. Press it 

to open the sidebar then look for the Show Document Outline button. If there is 

none available, then there are no headings in the document. Use the Adobe 

Acrobat app for Android or iOS instead. 

• Opening the PDF in Adobe Acrobat Reader for Windows or Mac. 

o Click View, Show/Hide, Navigation Panes, Bookmarks. If there are none available, 

then there are no headings in the document. Use the Adobe Acrobat app for 

Android or iOS instead. 

Visually select content and listen to it being read out using text-to-speech tools 

 

Two different types of assistive technology read out text. Text-to-speech tools are for readers 

who can see the page and navigate visually but want to hear text content read out. The other 

assistive technology, screenreader tools, are for those who cannot see the page and need to 



 
navigate the hardware, software and written content by audio. Screenreaders are dealt with 

separately in the final section. 

Commercial text-to-speech tools exist but this guidance focuses on inbuilt text-to-speech 

options freely available to readers. It is worth noting that both text-to-speech and screen 

readers handle text very effectively but, in general, handle symbols and equations very poorly. 

Recommended approach 

• The Microsoft Edge browser has text-to-speech built in. Sometimes there can be a delay 

between activating text-to-speech and hearing the first audio but other than that the 

process is usually effective.  Open the PDF In the Microsoft Edge browser. Scroll to the 

page you want to read and either  

o click on the Read aloud button on the toolbar (highlighted below) or 

 

o right click on the page and select Read aloud. 

Alternative approaches. 

• The Adobe Acrobat app for Android and iOS also has text-to-

speech built in.  

o load a PDF in the app, 

o click on the three dots on the top right of the screen 

(1 in the screenshot) 

o when the options panel pops up, select the icon that 

looks like a headset (2 in the screenshot). 

o This will open a panel at the bottom of the screen 

with a play button, fast forward and rewind. You can 

also change the speed of playback if you prefer to 

listen at faster or slower rate. 

 

Navigate effectively and listen to all content using screenreader tools. 

People with difficulty seeing the screen generally use screenreader tools that allow them to 

control their device and read the content using audio feedback. The choice of screenreader is 

highly individual. For day-to-day use, people may use phones / tablets with Android’s inbuilt Talk 

Back or Apple’s inbuilt Voice Over. People using Windows PCs may use Windows Narrator. 

Beyond these there are open source screenreader such as NVDA and commercial tools such as 

JAWS, SuperNova and others. It’s a complicated landscape. The screenreader interacts with the 

PDF content through the reading tools (browser, Adobe Acrobat Reader etc).  



 
Research by the Information Access Group in Australia (May 2022) suggested the worst 

screenreader experience was reading PDFs through the browser – with the exception of the 

Safari browser.  

Our suggestion is that – currently – the best screen reading experience will be with a  

• NVDA, JAWS or SuperNova with Adobe Acrobat Reader (Windows) or  

• VoiceOver with Safari (Mac).  

https://www.informationaccessgroup.com/news/pdf-viewers-screen-readers.html

	Digital Content Store: Accessibility opportunities 
	The accessibility potential of digital content 
	Understanding the accessibility jungle 
	Exploring the variables 

	Accessibility advice for HE contributors 
	Born digital content 
	Scanned content 
	Preparation and imaging: 
	Postprocessing 1: optical character recognition 
	Postprocessing 2: tagging for accessibility 

	Checking DCS content for a disabled user 
	Quick check 1 – Copy/pasting 
	Quick check 2 – OCR and reading order  
	Quick check 3 – Navigation 
	Quick check 4 – Magnification with reflow 
	Quick check 5 – Colour change 


	Accessibility advice for readers – tools and approaches 
	The art of the possible 
	Comparing PDF readers for personalisation options (best to worst) 
	Alternative approaches. 
	Image of text 
	Actual text 


	Accessibility advice for readers – needs and preferences 
	Change background / foreground colours  
	Recommended approach 
	Alternative options 

	Magnify text (up to 400%) and have it reflow to fit the screen width 
	Recommended approach 
	Alternative approaches. 

	Change line spacing and letter spacing 
	Recommended approach 
	Alternative approaches. 

	Navigate instantly to any part of the document using headings and subheadings 
	Recommended approach. 
	Alternative approaches. 

	Visually select content and listen to it being read out using text-to-speech tools 
	Recommended approach 
	Alternative approaches. 

	Navigate effectively and listen to all content using screenreader tools. 



